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製品紹介  
 

Topaz Adjust v3（トパーズ アジャスト バージョン３）は個性的かつ独創的な露出効果および

色彩効果を実現する最先端の Photoshopプラグインソフトです。主な機能としては、画像をよりよいも

のにするという以下の５項目があります。 

 

１． 画像を全体的にライトを照らしたようにバランスよく見せたり、エッジを鋭くはっきりとした

印象に見せたりできるように露出の調整が可能です。 

２． 高度な色彩調整技術により個性的な色彩効果が可能です。 

３． 革新的な画像細部調整機能により思いのままの強調やぼかしを可能とします。 

４． ISOノイズや JPEG圧縮による画像ムラの低減を可能とします。 

５． 露出、色彩、細部の全側面からの画像補正を可能とします。また、最大限の実用性と利便性を

引き出すため、設定したパラメータの保存・適用を可能とします。 

 

Topaz Adjustは設定の微調整やレイヤ調整に時間をかけず、効率的な画像補正操作を可能とするよう

精巧なアルゴリズムを使用しています。また、画像補正を始める上で簡単に調整できるようにいくつも

のプリセット機能が備えられています。 

 Topaz Adjust にはたくさんのパラメータがありますが、その操作は直感的でわかりやいものとなって

います。各パラメータにマウスカーソルを当てるとツールチップ（ふきだしによる説明文）が表示され、

そのパラメータがどのような画像効果をもたらすのか確認できます。 

  

 本ソフトウェアに関してご意見・ご質問などがございましたら http://www.club-nixus.jp のサポートペ

ージをご覧ください。 
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はじめに  
 

Topaz Adjustはそれ自体では使用できず、Photoshopなどの互換性のあるホストプログラム上で動作

するプラグインソフトです。これらのホストプログラムに Topaz Adjust をインストールすることで使用

することができます。 

Topaz Adjust を使用するためには、最初に Photoshopもしくは他の互換性のあるホストプログラム 

(Paint Shop Pro, Irfanview, Elements, など) を起動し、修正したい画像を開きます。次に Photoshopのフ

ィルタメニューにおいて Topaz Labs -> Topaz Adjust という項目をクリックすると Topaz Adjust の編集

ウインドウが開きます。  

Topaz Adjustは他に類を見ない画像補正技術により、詳細な露光補正および独創的な効果を発揮する

フィルタです。これらの効果を説明文から理解することは難しいかもしれませんが、実際に操作して視

覚的に実感することにより効率的な学習が可能となります。したがって、本ユーザーズガイドに記載さ

れている詳細な説明文は、より理解を深めるための参考としてご使用していただければよいかと思われ

ます。 
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インストール  

Topaz Adjustはそれ自体では使用できず、Photoshopなどの互換性のあるホストプログラムを必要とす

るプラグインソフトです。 

 

１． Photoshopやその他画像編集アプリケーションを起動中の場合は、それらをすべて終了してください。 

２． インストールCD,又はダウンロードしたファイルの“Topaz Adjust zip”ファイルを開きインストー

ラをダブルクリックしてください。インストールウィンドウが開いたら指示に従いインストールを

進めてください。 

 
３. PhotoshopがインストールされていればTopazのプラグインファイルがPhotoshopの“plug-ins” と

いうフォルダ内に自動的にインストールされます。 

４. インストールの後、ライセンスキーもしくはトライアルキーを入力して下さい。 

キー入力  

１． Photoshopにある画像を開きます。 

２． Filters -> Topaz Labs -> Adjust -> Menu -> Enter keyへと進みます。 

３． それからコピー&ペースト、あるいはキーを入力します。 

ホスト別インストール  

Topaz Adjustは Photoshopプラグインをサポートするほとんどのホストアプリケーションで動作しま

す。これらのホストアプリケーションには、主に Paint Shop Pro、 Painter、 Irfanviewなどがあります。 

 

Topaz Adjustのインストール方法はホストプログラムによって異なります。 

Paint Shop Proや Photo Impact、Irfanviewに Topaz Adjustをインストールするには、まず既定の場所

に Topaz Adjustをダウンロードして下さい。そして各ホストが指示する方法にしたがってインストール

を進めてください。以降よりこれらのインストール方法を示します。 
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Paintshop Pro / Photo Impactへのイントール方法  

１． まず PaintShop Pro / Photo Impactを起動して下さい。 

２． “File Types”リストの中で“Plug-ins” を選択し、Menu file -> Preferences -> File Locationsから

“Add”をクリックして下さい。 

 
 

３． C:\Program Files\Topaz Labs\Topaz Adjust 3 plug-ins を選択し、“OK”をクリックして下さい。 
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4. Topaz Adjustが使用できます。Effects -> Plugins へ進み “Topaz Adjust 3”を選択して下さい。 
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Irfranviewへのインストール方法  

 
１． Irfanview ウェブページ (http://www.irfanview.com：英語)にて入手可能な Plugins/Addonsをインス

トール済みであることを確認してください。 

 

 
 

２． Irfanviewを開き、 Image -> Effects -> Adobe 8BF filtersに進んで下さい。 
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３． ポップアップスクリーンで “Add 8BF filters”を選択し the C:\Program Files\Topaz Labs\Topaz 

Adjust \Plugins フォルダを選択して“OK”をクリックして下さい。Available/Loadable 8BF Filters 

セクションに“Topaz Adjust 3”が表示されるようになります。 

 
 

４． Topaz Adjustを使用するには、Image -> Effects> Adobe 8BF filtersと進み、“Topaz Adjust 3”を

選択してください。 
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Topaz Adjustユーザインターフェース  

 

Topaz Adjust  ユーザインターフェースを以下に示します。 

 

 
 

ボタンやパラメータ設定といったすべての GUIには、それらの機能を説明するヘルプ機能が備え付け

られています。これらのヘルプ機能はデフォルト（通常）では無効となっていますが、有効にしてマウ

スカーソルをそれらのアイテム上に 1秒間置くと、ふきだしの形をしたヘルプバルーンとともにそのア

イテムを説明する情報が表示されます。ヘルプ機能を有効にするには、右下の” Menu（メニュー）”から” 

Preferences（プリファレンセス）”を選択し、“Enable popup help（ポップアップヘルプを有効にす

る）”にチェックを入れてください。 

左側のウインドウにはプリセットをプレビュー、適用、操作するプリセットパネルが表示されていま

す。 

右上部の大きな画像は画像処理後のプレビューを表示する Preview（プレビュー）セクションです。

プレビュー画像をスクロールするには、プレビュー画像上でマウスを左クリックしたまま、ドラッグし
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ます。Menu -> Preferencesの “Pan Preview faster（パン操作によるプレビューの高速化）”にチェ

ックを入れることにより画面移動を高速化できます。 

フィルタ画像とフィルタなし画像を比較するためには、“View Original Image（フィルタなし画像の

表示）”ボタンをクリックします。クリックしたままの状態でフィルタなし画像を確認することができま

す。ボタンを離すと現在編集中のフィルタ画像に戻ります。このようにフィルタ前後を確認するために

フィルタ画像とフィルタなし画像を交互に切り替えることが出来ます。またスペースキーによっても

“View Original Image”ボタンを操作できます。 

プレビュー画像の下の“+”、あるいは“-”ボタンをクリックしプレビュー画像を拡大・縮小でき、ウイ

ンドウの大きさも調節できます。“Fit”ボタンは全体画像を画面にフィットさせます。100%未満における

画像サイズ変更では、プレビュー更新速度を速めるために内部的にサイズ変更が行われます。 

本ソフトではいくつかのショートカットキーが使用できます。スペースキーによりフィルタ前後の画

像を比較できます。Photoshop と同じく、“Ctrl +” と “Ctrl –”により画像の拡大・縮小が可能です。矢印

キーにより現在選択されているスライダーの調節が可能です。ショートカットキーの全リストはこのマ

ニュアルの後半をご覧ください。 

全てのフィルタパラメータは画像プレビュー下のタブ付きパネルにあります。 

以降のセクションではプリセットパネルの簡単な概要を説明します。 

画像モード  

 

Photoshopおよびその他ホストソフトウェアはグレースケール、 RGB、LAB、CMYKなどを含む多く

の画像モードをサポートします。画像はチャンネルごとに、8, 16, あるいは 32 ビットの画像を処理する

ことができます。Topaz Adjust はチャンネルごとに 8、16ビットの両方をサポートします。 

Topaz Adjust は RGBモードのみサポートします。モノクロ写真においては最初に RGBモードに変換

します。 

もし Filters menu（フィルタメニュー）においてフィルタの名前が灰色になっていたら、画像が開かれて

いないか、サポートされていない画像モードを使用している可能性があります。  
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プリセットの使用方法  
 

プリセットは Topaz Adjust のプロセスを簡略化、高速化するためのす

ばらしい機能です。これは Topaz Adjust によって設定されたパラメータ

を反映した「ひな型」として機能し、いつでも画像に適用することがで

きます。Topaz Adjust にはいくつかのプリセットがデフォルトで用意さ

れています。プリセットの個々の画像によって表現は異なります。

したがって、全ての写真にプリセットが最良の表現をするとは限りませ

ん。特に Topaz Adjust は画像のサイズにより結果が大きく変わります。 

最良の画像を得るためには、数あるプリセットの中から自分のイメージ

する画像に近いものを適用し、それに自分なりの微調整を加えていくと

よいでしょう。 

 

プリセットの適用方法  

 

プリセットを適用するために、左側に並んだ好みのプリセットをクリ

ックするだけです。プリセットをクリックすると、すべてのパラメータ

が自動的に設定されます。その後、パラメータを微調整してください。 

個々のプレビューの代わりにリストモードでプリセットを見たい場合、

Previewメニューをクリックして“Toggle list/Thumbnail”を選択してください。このモード切替えには数

秒かかることがあります。リストビューを使用することで Topaz Adjustの起動動作を高速化できます。 

 

スナップショット  

 

Topaz Adjustの機能としてスナップショットがあります。  

 

 
 スナップショット機能は作成した画像をプリセットとして保存することなく一時的に保存し２つ

までのセッティングを比較することを可能とします。たとえば、ある画像において２つの異なる設定が

どう作用するかを確認したい場合、その両方をプリセットに保存、適用、削除することなくスナップシ

ョットに保持するだけで簡単に比較することができます。 
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現在の設定をメモリに保持するためにスナップショットを使用するには、単純に Snap 1 もしくは Snap 

2をクリックしてください。Recall 1 もしくは Recall 2をクリックすることでプリセットの操作と同じ

ように Snap 1 もしくは Snap 2の設定をプレビュー画像に適用することが出来ます。ただし、Topaz 

Adjustで使用しているスナップショットは Topaz Adjust起動中のみ使用可能であるので Topaz Adjust終

了時、これらのスナップショットはすべて削除されますのでご注意ください。 

 

プリセットプレビュー  
 

 Topaz Adjust では各プリセット名の上に小さなサムネイル画像があ

ります。そのため、異なる設定をプレビューに適用することなく確認でき

ます。 

複数のプリセットをサムネイルの代わりにリスト表示したい場合は、メ

ニューの Presetから“Toggle List/Thumbnails”を選択してください。これは

Topaz Adjust の初期化速度を向上させるのに効果的です。 

メインプレビュー画面を拡大・縮小、表示移動してから、プリセットのサムネイル画像にそのメイン

と同じ部分を表示したい場合は、 @ボタンをクリックしてください。その後すべてのプリセットに反映

されます。 

 

プリセットメニュー  

 

 Topaz Adjustには複数の多様なパラメータがあるため、プリセット

の設定や後で使用するための設定を保存する機能は非常に便利な機能

です。設定を保存するためには、Presets メニューから“Save…”ボタン

をクリックしてください。 

プリセット名と任意の記述を入力し OKをクリックして下さい。入

力した名前がすでに存在する場合、新しいプリセットを作成する代わ

りに、Topaz Adjustは既存のプリセットを上書きしますのでご注意下さい。また Adjustのプリセットフ

ォルダ内をテキストエディタにより手動で書き換えない限り、すでに提供されているデフォルトプリセ

ットを上書・削除することはできません。 

保存したプリセットは Topaz Adjustをインストールした C:\Program Files\Topaz Labs\Topaz Adjust 

2\Presets内の“Presets”フォルダ内にあります。それ以外のフォルダにインストールした場合は上記フォ

ルダ以外に保存されます。Presets フォルダ内にはすでにいくつかのプリセットファイルが存在していま

す。保存したプリセットは”プリセット名.tpp”で新規ファイルとして保存されます。保存したプリセット
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ファイルを Topaz Adjustをインストールしている他のユーザに eメールで転送し、そのファイルを

Presetsフォルダに保存することで共有することも可能です。 

新規プリセットは Topaz Adjust のプリセットメニューに追加され、プレビューが自動的に生成されま

す。後でそのプリセットを使用したければ、メニューから生成されたプリセットを他と同様にクリック

してください。 

プリセットを削除したければ、Delete (削除)オプションを使用し選択したプリセットを削除すること

ができます。 

プリセットファイルをインポートするには、Import (インポート)ボタンをクリックして下さい。 

ブラウズボックスが出現し、あなたのコンピュータに保存されている Topaz Adjust プリセットが表示

されます。これは使用したいプリセットファイルをダウンロードすれるときに便利です。 

インターネットから直接プリセットファイルをインポートするには、Import from Internet…ボタンを

クリックし、プリセットファイルのあるフォルダ内にそれらをダウンロードしてください。 

プリセットファイルを特定の場所にエクスポートするには、“Export”をクリックしてください。

その後、このファイルをインポートした他のユーザと共有できるようになります。 
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設定とパラメータ  

 

Topaz Adjust には Exposure, Details, Color, Noise といった 4つの調整タブがあります。上達のポイ

ントは各パラメータを実際に調節してその効果を自分の目で確認することです。文章で説明するより視

覚的に実感したほうが早く理解できるからです。 

以下に各パラメータの使用方法および活用方法を示します。 

一般に Exposureタブから始め、Details、Color、 Noiseという順にパラメータを調節していきます。 

 

EXPOSURE (露光) 

 

 
 

Exposure タブで画像の露光バランスをとるために適応技術を使用します。露光に関する問題を修正し、

様々な独創的効果の適用が可能となります。６つのパラメータの組み合わせにより数え切れないほど多

様な効果を生みだします。 

 

Adaptive Exposure (適応的露光) 

 画像セクションの露光を一定にし、露光バランスをとります。この設定は Rigions 設定と共に連

結して作動します。0とすると Exposure タブ自体を無効にし、1とすると Exposure タブを最

大限に適用します。  

Regions (露光区分) 

Adaptive Exposure (適応的露光)処理を行なうための画像区分を決め、分割します。高い値ほど

より狭い範囲でのコントラスト処理および細部の強調を実施します。 

Contrast ( コントラスト) 

露光補正がヒストグラム上で”U”(谷)型か、あるいは”n”(丘)型を示します。標準的なコントラスト

調整とは異なります。 

Brightness (輝度) 
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標準の輝度調整パラメータです。高い値ほど画像全体の輝度が増加します。 

Highlight (ハイライト) 

Topaz Adjustにはハイライトの白飛び抑制機能が内蔵されています。高い値ほど白飛びを抑える

範囲を増加させます。0とすると白飛びの抑制を無効にします。 

Shadow (暗部) 

暗部の諧調保護機能が内蔵されています。高い値ほど暗部の諧調を上げ黒潰れを防ぎます。0と

すると暗部の保護を無効にします。 

 

DETAILS (細部) 

 

 
 

Details タブを使用すると画像の中の大きな領域とは独立して、細部の強調と抑制を行うことができます。

パラメータの組み合わせにより非常に多くの設定パターンが考えられるため、ユーザ独自の設定が可能

となります。 

 

Strength (強度) 

これは“Details Threshold”  (細部の閾値)によって決められる画質向上度合いです。1.0以上では

細部を強調し、1.0未満では細部を抑制し滑らかさを保持します。 

Boost (増強) 

細部の中のさらに細部を強調する度合いを調節します。1.0以上では特徴の弱い細部を強調し、

1.0未満では特徴の弱い細部を抑制します。このパラメータは主にコントラストの弱い細部に影

響します。コントラストの強い細部においては主に Strengthにより調節します。 

Threshold (しきい値) 

しきい値を大きくとると、より高いコントラストを細部とみなします。その結果細部は省略され

ていきます。しきい値を小さくすると、コントラストの低い領域も細部とみなします。 

Radius (範囲) 

大きくて目立つ細部はより強調され、小さくて淡い細部はより抑制されます。 

Sharpen (鮮明度) 
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画像を鮮明にする度合いです。単純に小さくて不鮮明な部分を抑制することで簡単に画像を鋭く

見せることができます。もし画像に Sharpenを適用することが最重要であれば、Topaz Vivacity

に付属している Topaz Sharpenを使用してください。 

Process details independent of exposure (露光と細部の処理を関連付けない) 

これは v3.0からの新しい機能となります。チェックボックスにチェックを入れると細部処理は

露光に影響を与えません。チェックボックスにチェックが入っていない場合は、v2.xと同様の処

理となります。したがって、狭い範囲でのコントラストを増加した場合、細部も強調されます。

ほとんどの画像に関してはよい結果をもたらしますが、空のような滑らかな画像においてはノイ

ズもともに強調される可能性があります。 

チェックボックスが入っていれば、Exposureタブによって内在する露光のみを、Detailタブに

よって画像の詳細のみを調整することになります。これは Topaz Adjustの操作においてさらな

る柔軟性を発揮し、より全体的なノイズ除去を可能とします。 

 

COLOR (カラー) 

 

 
 

Color (カラー)タブでは適応的な色彩調整を適用しています。これは色に対して作用するということ以外

はほとんど Exposureタブと変わりありません。このタブにて魅力的な色彩効果を演出してください。 

 

Adaptive Saturation: (適応的彩度) 

画像セクションの彩度を一定にし、彩度バランスをとります。この設定は Rigions 設定と共に連

結して作動します。0とすると Colorタブ自体を無効にし、1とすると Colorタブを最大限に適

用します。 

Regions (分割数) 

Adaptive Exposure (適応的露光)処理を行なうための画像区分を決め、分割します。高い値ほど

彩度のより狭い範囲でのコントラスト処理を実施します。 

Saturation (彩度) 
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 画像全体の彩度を増減する標準パラメータです。 

Saturation Boost (彩度増強) 

 彩度をさらに増減させます。 

Hue (色相) 

 色相を補正制御することができます。 

 

NOISE (ノイズ) 

 

 
 

 

Topaz Adjustの noiseアルゴリズムはほとんどの画像において最適にノイズの量および種類を検出でき

ます。これは処理速度と利便性を考慮して設計され、非常に高速できびきびした動作を示します。さら

にユーザは“use Topaz DeNoise（Topaz DeNoiseの使用）”というチェックボックスにチェックを

入れることにより、処理速度を犠牲にしてノイズ除去性能を上げることを選択できます。(これは特別な

オプションを使用しない Topaz DeNoiseの“Fast(高速)”モードと同等です。さらに高品質なノイズ低

減を適用したい場合は Topaz DeNoiseフィルタを使用してください。) 

 

Suppression (抑制) 

このタブでは、自動的にノイズの分布を検出し、それらの軽減度合いを調節します。1にすると

Topaz Adjustによって算出されたノイズの 100%が除去されます。それより高い値はさらに多く

（ノイズマップに比例して）、低い値は少ないノイズを除去します。このフィルタは一般的にノ

イズ推定能力に優れているので、初期値として 1が設定されています。 

Amount (量 ) 

これは低減するノイズ量を示します。高い値ほどノイズの低減度合いを上げます。0はノイズ低

減なしで、1は最大限ノイズを低減します。ノイズマップに対して Photoshopの“不透明度”と

同じような設定をすることができます。 
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JPEG Artifacts Removals (JPEG 圧縮による画像ムラの除去) 

チェッカーボーディング(=ブロックノイズ)やモスキートノイズといった JPEG の画像ムラを除

去します。これは圧縮率の高い画像を編集する際にのみ使用してください。なぜなら、他の

Topaz Adjust機能は JPEG の画像ムラを拡大する傾向にあるからです。しかし、この機能にお

ける処理速度は他の機能に比べると低速なので、最後の仕上げ段階で適用することをお勧めしま

す。 
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Menu (メニュー) 

 

フィルタウインドウの右下にある Menuボタンより Topaz Adjust 

のメニューにアクセスできます。 

I’m feeling very lucky! ボタンは露出、細部、色彩といったパ

ラメータを瞬時にランダム設定します。通常は極端な結果になるこ

とが多いですが、遊び心があり、アイディアを出したい時に使うと

良いでしょう。I’m feeling very lucky! ボタンは現在のタブのみ

をランダム設定します。 

Shareボタンは現在の設定を eメールやフォーラムに自動的に添

付する機能です。これは設定を共有したいけれど保存やプリセット

のエクスポートが面倒なときに便利です。 

About…ボタンは Topaz Adjust のバージョン情報およびホームページアドレスを表示します。 

Online Resource…ボタンはビデオチュートリアル（使用例）や現在あなたが表示している画像に対

する提案が得られる Topaz Adjust のホームページにリンクします。 

User’s Guide…ボタンではこのユーザーズガイドを開きます。 

Enter Key…ボタンはライセンスキーの入力に使用します。ライセンスキーをすでに入力済みであれば、

このボタンを無視してもかまいません。 

Check Update… ボタンによりユーザのコンピュータにインストールされている Topaz Adjust のバー

ジョンをチェックでき、最新バージョンが入手可能であればお知らせいたします。  

Preference…ボタンでは Topaz Adjust ウインドウのビジュアルカラーや他の追加機能を設定できます。

OKをクリックするとチェックされた設定が保存されます。 

Enable popup helpはマウスがフィルタエリアでホバ

リングした時に表示するツールチップ(ふきだしによる説

明)を有効にします。もし作業の妨げとなるようでしたら

オフにして下さい。 

Pan preview faster は Topaz Adjustプレビューのパン

速度（プレビューをつかんで移動させる速度）に影響し

ます。 
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ショートカットキー  

作業効率アップのため Topaz Adjustではいくつかのショートカットキー が使用できます。以下のキーは

全工程にて使用可能です。 

SPACEBAR オリジナル画像の確認 

CTRL-1 Snapshot 1呼び出し 

CTRL-2 Snapshot 2呼び出し 

ALT-1 Snapshot１の保持 

ALT-2 Snapshot２の保持 

CTRL-R 現在作業中のタブのリセット 

CTRL-ALT-R すべてリセット 

CTRL-0 画像サイズを画面にフィット 

CTRL-ALT-0 画像の 100%表示 

+ or CTRL-+ 拡大 

- or CTRL- - 縮小 

パラメータのスライダー（つまみ）にフォーカスがあれば（たいていはクリックによる）、値変更のた

め以下のキーが使用可能です。 

←、↑ 0.01ごと減少 

→、↓ 0.01ごと増加 

Page up 0.1ごと減少 

Page down 0.1ごと増加 

Home 最小に設定 

End  最大に設定 

最後にプリセットウインドウにフォーカスがあるとき、プリセットを選択するために↑、↓キーが使用

可能です。 
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Topaz Adjustの使用  
 

本セクションでは、どのように Topaz Adjustを使ったら最高の効果を表現できるか、いくつかの例を

紹介します。有能な写真家でさえ、完全な露光状態で撮影をするのは困難とされます。しかし、Topaz 

Adjustを使用することによってどんな画像でも簡単に思い通りの補正を可能とします。その例を以下に

示します。 
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これらは、プリセット(Exposure Correction)を１回適用し、少しだけ手を加えただけのものです。露光

の加減を誤ったとしても、直ちに問題を解決できるプリセットを使用して、その設定を登録できます。 
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Topaz Adjustは写真を補正するためだけに使用するわけではありません。とてもよく撮れている写真

でもポップな印象に仕上げたい場合などにも使用できます。 

このように Topaz Adjustは個性的な演出により自分だけのスタイルを簡単に創り上げることができる

のです。プリセットを使用したものと元画像の事例をご覧下さい。 
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これらの事例は画像の表面を削って仕上げただけの画像です。実際に使用してみると本ガイドよりも

鮮明な効果を確認することができると思います。その他多くの事例を参考にしたい場合は NIXUSのウェ

ブサイトにお越しください。 

 

http://www.nixus.jp  

 

ご質問やご提案、コメントなどございましたらいつでもお気軽に http://www.club-nixus.jp までお越し

ください。  

 

 

  

 

 


